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Congratulations!
You will soon be processing your photos through the World’s 
fastest and most advanced automatic image correction 
science available on this planet!

Perfectly Clear is award winning technology with over 10 
patented corrections and more than 10 years of scientific 
research1, The benefit is Real Color Photography® – accurately 
beautiful corrections - ensuring that your memories are 
perfectly preserved.

Our mission is to save you significant time while producing 
outstanding quality. Automatically.

2 Eight out of ten times, in a blind test, Professionals using Photoshop selected the Perfectly 
Clear instant correction over their own work, which averaged 10 minutes to enhance.
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Why Perfectly Clear?
Proven Results - Perfectly Clear is powering the automatic corrections of over 85,000 photo kiosks, 
2,500 printers, countless online sites and labs, and you`ve likely used Perfectly Clear if you`ve ever 
printed to Walgreens, Black`s, Tesco, photobox, photoworks, or Olympus.  
(www.athentech.com/Our-Licensees.html)

Real Color Photography® - Our corrections are accurately beautiful. This means that your blue eyes 
should be blue, green grass should be green, and your purple bride`s maid dress should be purple!

Backed by Science - Our scientific approach mimics the physics principals of light – the same way the 
human eye captures light. We correct each pixel independently – it is as if your 21 megapixel photo was 
taken with 21 million separate apertures. (www.athentech.com/Science.html)

Saving you time - We gave Photoshop experts 10 different images and asked them to manually correct 
them. On average, this took 5-7 minutes per photo. The original photos were then processed through 
Perfectly Clear – average time 2 seconds per photo. We then asked which photo was preferred – 8 out 
of ten times the Perfectly Clear photo was preferred!

Recognized - Perfectly Clear has been granted several awards and accolades for the value it adds to 
photographers by saving them time and making their editing effortless and much less time consuming.

1 Perfectly Clear Patents: United Kingdom Patent No. 2363933, European Patent No. 1177678, U.S. Patent Nos. 
6677959 & 6633684, Singapore Patent No. 83972 & 94006, HK 1048213, New Zealand 523251 & 514714, Australia 
771979, Mexico 233930 & 227042, Canada 2368544, China ZL 00808690.7, India 217854, Japan 4175461, Korea 
572444. FotoNation Red-Eye Patents: US 6,407,777 and US 6,042,505 and US 7,042,505. Other patents pending 
for Perfectly Clear, FotoNation, Tribeca Imaging and Stoik Imaging.
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Minimum System Requirements 
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• Windows O/S: Windows XP, Vista, Windows 7

• Mac OSX Leopard, Snow Leopard, Lion

• Photoshop CS3/CS4/CS5/CS6

• Elements 8, 9, 10

• 2 GB of RAM 
   (4 GB recommended)

Perfectly Clear works with both 8 bit and 16 bit images, 32 and 
64 bit processors. 
 
For raw images, Perfectly Clear uses the 16 bit image passed to 
it and processed with Adobe Camera Raw.



Chapter 2
How do I install the software?

Free trial and buying the software
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1. Installation
Prior to installation, please ensure the image editing application that will serve as the host of Perfectly 
Clear is closed. Please also close any other open applications for the duration of the installation process. 
To begin the installation process, double-click on the installer provided either on your Perfectly Clear 
CD or from the download process from the Athentech (www.athentech.com) web page.

The installer will walk you through the various steps necessary in order to install Perfectly Clear into 
your image editing application of choice.  On Windows, you may get a message similar to the one 
below, just press “Run” or “Yes”.

After accepting the End User License Agreement, the installer will automatically attempt to locate all 
installed versions of Adobe Photoshop or Adobe Photoshop Elements, and then display the location 
where the files will be installed.

If the installer was unable to locate a version of Adobe Photoshop or Adobe Photoshop Elements, or 
if you are using a different image editing application, you will need to manually locate the appropriate 
plug-in installation location. 

For Adobe Photoshop or Adobe Photoshop Elements, the install location is as follows:

For Windows, this is (one or both depending if you are running 64 bit):
C:\Program Files\Adobe\Adobe Photoshop\Plug-Ins 
C:\Program Files (x86)\Adobe\Adobe Photoshop\Plug-Ins 

For Mac this is:
Macintosh HD : Applications : Adobe Photoshop : Plug- Ins : Filter

Figure 1 - Run Application (Windows)



2. Launching Perfectly Clear Photoshop Plug-in
Once you have Photoshop loaded, select “Athentech Imaging/Perfectly Clear” from the Filters menu. 
See Figure 2.
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Figure 2 - Launching Perfectly Clear
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Figure 3 - Licensing Window   (Windows) 

3. Running in Trial Mode
While in trial mode, the first time each day you run Perfectly Clear Photoshop Plug-in the following 
window will appear:
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Figure 3 - Licensing Window   (Mac) 

Buy Perfectly Clear Photoshop Plug-in -  
This will take you back to our website. (More details later on in this chapter.)

Activate Perfectly Clear Photoshop Plug-in -  
This option will be used once the software has been purchased and you have an activation key

Trial Perfectly Clear Photoshop Plug-in for 30 days -  
Choose this to trial our software.  The trial is fully functional with no restrictions or watermarks.
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Figure 4 - Activating (Windows)

4. Buying Perfectly Clear Photoshop Plug-in
To purchase a license key, simply choose the “Buy Perfectly Clear…” button. This will redirect you to 
our website where you can purchase Perfectly Clear Photoshop Plug-in. You have the convenient 
options of using any major credit card or PayPal. 

**You MUST use a valid email to purchase Perfectly Clear  
as your activation key will be emailed to you.

5. Activating Perfectly Clear Photoshop Plug-in
Once you have your license number/activation key (you will receive an email if you purchased online, 
or it may be attached to you CD or box if you made a physical purchase) simply choose `Activate 
Perfectly Clear...` (Figure 3), enter your license number into the open box and press the “Activate” 
button (Figure 4). The software will connect to the internet to activate.
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Figure 4 - Activating (Mac)

From time to time firewalls will block the activation process. If this happens to you please follow these 
steps to bypass this problem.

i) Click on “Import Activation Certificate” (Figure 4) or the “Import Certificate” button 
on a Mac, this will bring up another dialog box (Figure 5). 
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Figure 5 - Importing Activation ID (Windows)

Figure 5 - Importing Activation ID (Mac)
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ii) Click on “Use the browser to get an Activation Certificate” or “Activate on Website” 
(Mac). This will bring you to Nalperion Trusted Activation website (Figure 6).

iii) Copy the Installation ID and License Number (these may be populated on screen, if 
not then please see your original email) as you see in Figure 5.

iv) Paste those numbers into the website (Figure 6), review and agree to the terms  
and conditions.

v) Click on “Generate Unlock Code/Certificate”.

Figure 6 - Trusted Activation Website



vi) Copy and paste the Unlock Code (Figure 7) into the box provided in (Figure 5).

vii) Click Import. 
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Figure 7 -Unlocking Code
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Figure 8 - Registering 

6. Registration
Now that Perfectly Clear Photoshop Plug-in is active on your computer you have the option of registering 
your newly purchased software. This registration process is optional but there are some powerful 
management benefits to registering. The registration box (Figure 8) pops up after you accept the 
registration key, asking for your name, address, email and a few other details, most boxes are optional. 

Once you`ve registered you create a login name and password and with that you are able to login 
on the website. There you can manage License Keys you’ve purchased, see how many actions/de-
activations have been done.

If you decide to not use this registration feature please go to the next step.
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Figure 9 - De-Activating - Windows

7. Deactivating/Transferring your License Key
After you have activated and registered your License Key (registration optional) you can deactivate if 
you so choose. The main purpose of deactivating would be to transfer your license to another computer.

In order to do this start up Perfectly Clear Photoshop Plug-in and click the “about” button then the 
“License” button, simply press the “De-Activate Perfectly Clear…” option and follow the on-screen 
instructions (Figure 9). Make sure you read the conditions of de-activating your license and choose 
“yes” before clicking “continue”.

License information, including your license key, is available at any time simply by clicking the 
“About” button once you’ve launched Perfectly Clear Photoshop Plug-in.
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Figure 9 - De-Activating - Mac
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Chapter 3
Lets Start Correcting!

How to use the software
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To launch the Perfectly Clear Plug-in, open a photo in Photoshop or Elements and then select 
“Athentech Imaging/Perfectly Clear” from the Filters menu. 

Once Perfectly Clear Photoshop Plug-in is launched, it will automatically process your photo using 
your last preset selected (if this is the first time you’ve used Perfectly Clear, then it will use the 
default preset).

1. Select your View
There are 3 different views as indicated by the toggle buttons in the upper right :

A) Full Preview Window – to toggle between the original and corrected photo, simply mouse click 
and hold anywhere on the photo. Underneath the photo on the bottom right you will see an indicator 
showing you which photo you are viewing.

B) Side by side – press the 2nd button to show the original on the left, and the correction on  
the right

C) Top / bottom – press the 3rd button to show the original on the top and the corrected photo on 
the bottom.

1 2

3

4

Figure 10: Snapshot of Perfectly Clear Photoshop Plug-In and key features 



Page 22

Useful tips
1. Perfectly Clear Window re-sizeable
To adjust the viewing size of the Plug-in window, click the bottom right corner and drag 
to re-size.  This size will be remembered for the next time you launch.

2. Applying Perfectly Clear to a selection
You can choose a selection/portion of your photo in Photoshop and Perfectly Clear will 
only be applied to the selected area 

3. Short-cut keys
i) Slider bars can be adjusted using your mouse scroll wheel (if your mouse has this),
ii)  “ctrl” (Windows) / “command” (Mac) “+ / -“ shortcut keys for zooming

2. Choose your preset
Perfectly Clear comes with 6 pre-defined presets. When you launch the plug-in, your photo will be 
corrected with the last preset used. To change, simply choose another preset from the drop-down 
menu. You can also create as many custom presets as you desire. More information on each preset is 
outlined in Chapter 4.

3. Zoom to see the details and quickly navigate
To see the details of your image, simple slide the zoom slider to the right for more details. The area 
that you’re viewing is displayed in the red box in the Navigator window in the bottom right. You can 
move the image around by:

A) Mouse click and hold, then drag the large preview photo around
B) Moving the red box in the Navigator window around
C) Clicking anywhere in the Navigator window.

4. Fine tune your correction
The right panel contains all of our algorithms. Simply toggle ON or OFF by checking the box, 
or adjust a slider bar to see the effect of each algorithm. More information on each algorithm is 
available at www.athentech.com.

So really, that’s all there is to better pictures, effortlessly!



Chapter 4
Workflow

Where and when to use Perfectly Clear with your images
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Perfectly Clear is designed to save you significant time in your editing process.  It should be used as 
a first step in your image correction workflow to remove the 13 problems created by digital cameras, 
specifically: under-exposure, lack of depth, lack of sharpness, lack of color vibrancy, lack of color 
fidelity, abnormal tint, noise, red-eye, and incorrect skin tones.

After you have used Perfectly Clear, you can then apply your creative talent to give your photos an 
artistic look, whether that is HDR, Black & White, soft focus, etc.

Thus you should apply the Perfectly Clear Photoshop Plug-in as a first step to your photos in Photoshop, 
before using other filters, plug-ins, or correction tools.  If you are using raw files, please perform minimal 
adjustments in Adobe Camera Raw.  We want to bring the photo into Photoshop with as much of the 
original information as possible for Perfectly Clear to work with.

Step 1 
Automatically Correct with Perfectly Clear

Our automatic correction should get you  
80% - 100% of the correction that you require.   

This is where the time saving occurs.

Step 2 
Fine Tune with Perfectly Clear 

If Perfectly Clear didn’t get you your  
desired result automatically, then simply  
choose another preset, and/or adjust any  

of the slider bars for each correction.

Step 3 
Apply Your Artistic Talent 

Last, you can use other plug-ins or filters  
or tools to apply your unique creative talent  

to give your photos your special touch.
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Chapter 5
The Power of Presets

How to use each of the Presets and create your own
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Perfectly Clear Photoshop Plug-in comes equipped with 6  
pre-loaded presets (called “system presets”).
1. Default
2. Landscape
3. Portrait
4. Noise Removal
5. Fix Dark
6. Tint Removal

Let’s look at the attributes of each profile and when we might want to use them:

1. Default
A robust preset that works excellent on a very wide variety of your photos (indoor, outdoor, flash 
photography, portrait, etc). The most common algorithms are turned ON: exposure, contrast (depth), 
sharpening (crispness), color vibrancy, and auto red-eye. You can comfortably process a large variety 
of photos knowing that no damage will be done to them. The below example shows a typical example:
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2. Landscape
This preset is designed for outdoor shooting with no flash photography (no red-eyes) and natural 
sunlight. Exposure, color vibrancy, sharpening and depth will all be corrected. It will create a natural 
looking outdoor look, with slightly less depth then the default setting. The example below show a 
typical shot to use with this:
 

3. Portrait
The “Portrait” setting has been developed for portrait photos, weddings, and close facial shots. It will 
slightly smooth skin and the blemishes in the face and create a more diffused, softer picture with less 
contrast.  It is great for accurately capturing purples (such as bride’s maid dresses and similar scenes) 
since cameras will capture this as blue, but we’ll correct back to the proper purple. Let’s look at the 
below example:
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4. Noise Removal
Camera phone images tend to be noisier. Also, if you shoot using high ISO settings, or at night, then 
your photos will be grainier. Furthermore, as digital cameras continue to add more pixels, then the 
photos will tend to be noisier. Use this preset for your noisy images to apply the very powerful Stoik 
noise removal algorithm to remove the nasty grain and noise from your photos as shown below.

5. Fix Dark
Use this preset for those really dark photos (caused by a subject back-lit by a bright background). 
This preset will turbo-charge the exposure to bring out significant details. Note: this will work magic 
on really dark photos in revealing the details, but these photos usually also contain lots of noise which 
may also be made more obvious as the darkness is removed .
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6. Tint Removal
Use this profile to remove abnormal tints (yellow, blue, etc.) from your photos that are caused by 
infrared, ultra-violet, incandescent, fluorescent or tungsten lighting:

Managing your presets
You can easily create an unlimited amount of your own special sauce for correcting photos. Simply 
adjust the various corrections to your desired preference, and select the “new” button located under the 
preset drop-down menu. Choose the name that you want to call it and optionally, enter a description 
that will appear in a pop-up above the preset when you move the mouse above the name. 

To remove, simply select and press “remove”.

Once you’ve created a preset, you will be able to edit it by pressing the “update” button.



Chapter 6
Fine Tuning

What if I want to fine tune the corrections?
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No problem!
There are a total of 10 different algorithms for you to adjust. Let’s look at what each algorithm does 
and how to fine tune it.

1. TINT CORRECTION: algorithm description
Abnormal tint occurs in situations where the sensors of the camera have inappropriately picked up and 
reflected in the image excess green from fluorescent lights, or excess red from the infrared heat of a 
person in the image, or excess blue from ultraviolet, or excess yellow from tungsten lights.

Perfectly Clear’s patent pending process will automatically remove these unwanted tints.

TINT CORRECTION: adjustments

When turned ON, this algorithm will look at each image and if there is an abnormal tint, remove it. You 
can adjust how much tint is removed – simply move the slider bar further to the right for more tint 
removal. If there is no tint, no correction will be performed and it will say “no tint detected”. 
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2. PERFECT EXPOSURE: algorithm description
Perfect Exposure is the most important algorithm and forms the core for all other corrections. Perfect 
Exposure optimizes the light exposure in every pixel. This patented approach corrects the image to 
emulate what the photographer and subjects saw at the time of taking the photo. 

A quick note on overexposed photos: We distinguish between overexposed (which will benefit from 
the Perfectly Clear process) and clipped images. The clipped portions of an image are considered to 
be those portions that exceed 255 on the RGB spectrum. Portions of the image which meet these 
criteria have no data in these areas, and where this occurs Athentech doesn’t hallucinate what might 
have been there.

PERFECT EXPOSURE: adjustments

By default, when Perfect Exposure is ON, so is Automatic Strength Selection. This means that Perfectly 
Clear will independently look at each photo and suggest a specific amount of exposure correction 
unique to that photo.

You can adjust how aggressive the Automatic Strength Selection is: Low, Medium, High. In general, a 
higher setting means a greater exposure correction per photo. 

You can also manually grab the slider bar and adjust. This allows you to override the auto correction.
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3. CONTRAST (DEPTH): algorithm description
This algorithm comes from the signal processing world (medical X-rays, for example).  In X-rays, the 
challenge is that there are over 4,000 shades of grey in a radiograph.

However, the human eye can only detect 50 -100 shades. The result is a radiographic image that 
appears blurry. Perfectly Clear for Radiography optimizes the contrast in each and every pixel so 
that the radiographer, doctor, or surgeon can easily discern the details throughout the entire image. 
As image quality in radiography means the difference between life and death, it’s essential that 
no artifacts are created and no information is deleted. We’ve taken this technology and retrofitted 
it to photography so that we can provide you with an image that is very eye-pleasing with lots of 
“punch & depth”. 

CONTRAST (DEPTH): adjustments

Since the eye perceives reality in 3-D, photographers also like lots of contrast/depth with their photos, 
and as such you’ll notice that it is usually set as quite high (on the right side of the slider) for the presets.

Please note that a contrast of 0% does not yield the same result as turning contrast off. Also note that 
when you choose to increase the Contrast your photos will usually benefit by increasing the defaults of 
Perfect Exposure since increasing contrast creates a photo that is overall slightly darker. 

For extremely dark photos, it is beneficial to turn depth “off” in order to bring out extreme details. 
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4. COLOR VIBRANCY: algorithm description
Perfectly Clear automatically checks and determines whether or not the capture device has captured 
the full vibrancy of the colors in the picture. If it hasn’t, then the algorithm will automatically restore 
the washed out/faded colors in the photograph while always maintaining the true colors represented 
in the original photo. If the camera has properly captured true color, then this function will have no 
effect on the image. 

COLOR VIBRANCY: adjustments

To enrich color vibrancy simply slide the slider bar to the right. Increasing Color Vibrancy may cause 
some clipping at the low end of the RGB spectrum but, it will never cause clipping at the bright end of 
the spectrum. Moving the slider to zero will increase the color density less and result in zero chance of 
clipping. You will note that on many images there is no increase in color vibrancy. This is because the 
camera sensors have already captured true color. There is a difference between a setting of “0” and 
turning the algorithm OFF.
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5. DIGITAL COLOR FIDELITY: algorithm description
Digital capture devices are currently incapable of reproducing the full visual spectrum of colors the eye 
sees. Point any digital camera at a purple object (Laker’s jersey, FedEx box, blue morning glory flower, 
for example) and compare the image on screen with the original purple object in front of you. What do 
you see? The purple object will appear blue on the screen! For example, see the two photos below – 
the photo on the left is an uncorrected photo directly from the digital camera. The jerseys are actually 
purple, but have been captured as blue by the camera. The photo on the right has been corrected with 
Digital Color Fidelity and correctly restores the proper purple exactly as seen by the human eyes in the 
real world.

Since True Color is fundamental to preserving precious memories perfectly, Athentech has partnered 
with Tribeca Labs to provide you with Digital Color Fidelity (“DCF”).  DCF is a patent-pending process 
which maps untrue colors created in the camera’s imaging pipe back into the true colors seen with the 
human eye at the time the photograph was taken. 

DIGITAL COLOR FIDELITY: adjustments

There are 2 settings that you can adjust: “Standard”, and “Vivid”.  Standard will re-map to the full color 
spectrum of the colors that the camera failed to capture. Vivid will do the same, but will accentuate the 
colors. The result is a photo with more contrast, more vivid colors, and more “punch” to it. The photos 
below show an example between the two settings:   

No corrections Perfectly Clear (“PC”) PC + Standard DCF PC + Vivid DCF



Page 36

6. SHARPENING: algorithm description
Perfectly Clear’s proprietary sharpening is a series of very powerful and unique algorithms developed 
to deliver a crisp looking photo that is artifact free.  

SHARPENING: adjustments

Simply select the check-box next to the “sharpen” dialog to activate and move the slider bar to the 
right for increased crispness and to the left for less sharpening.

7. NOISE REMOVAL: algorithm description
Athentech has partnered with Stoik Imaging in providing you with their patent pending noise removal 
technology. The Stoik engine is the fastest and most effective on the market for removing high and 
low ISO noise in photographs, grains in scanned images, JPEG compression artifacts, Moiré pattern 
effects and much more. 

Stoik Noise Autofix is the first photo noise reduction algorithm that allows for fully automatic operation. 
The algorithm will first analyze the photo to determine if noise exists, and only then apply the proper 
amount of noise removal. Specific algorithms and settings are applied depending on whether the 
photo was taken with a digital camera, camera phone, or scanner.
The algorithm includes modules of noise detection, noise analysis and noise filtration which are 
statistically trained to provide optimal balance between photo noise reduction and preservation of 
image details. Unlike other noise removal algorithms that blur photos after removing noise, the Stoik 
algorithm is unique in preserving the crisp details.

The noise in digital photos is reduced by 2 - 3 stops, so that the noise level of the photo shot at ISO 
1600 is effectively reduced to ISO 200 - 400 levels
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NOISE REMOVAL: adjustments

When noise removal is turned ON, there are 4 presets to choose:

A) Default – a robust, powerful setting for all camera corrections.

B) Camera Phone – a special engine has been added in to correct the grainy quality of most 
camera phone pictures

C) Night Scene - The night setting is optimized for shots where dark areas of the image are mixed 
with illuminated and potentially detail intensive areas. We find that the lower frequency noise is 
the biggest (and solvable) concern for these types of shots with potential noise blotches and color 
banding.

D) Portrait - The emphasis is to retain the structural and natural color composition but remove 
larger noise artifacts and blemishes while avoiding the over-processed, plastic look.

In addition, you can adjust the overall strength of the noise removal process by sliding the single slider 
bar – greater processing strength occurs the more the slider bar is to the right. Details slider bar can also 
adjust the amount of detail preservation.

****Please note that noise removal is the most time consuming of all of the algorithms. As such you 
may notice a speed hit when using this algorithm.  
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8. SKIN TONE CORRECTION: algorithm description
People emit Infrared Red (“IR”). Digital Camera sensors capture IR. The human eye doesn’t see IR. As 
a result, captured and correct photos often appear redder than they appear in the real world. This is 
especially true for indoor photos when taken with a flash. The Perfectly Clear Skin Tone Correction will 
automatically detect and remove the spurious IR from flesh tones while maintaining the proper reds in 
the other portion of the photo.

SKIN TONE CORRECTION: adjustments

To enable simply select and move to the right to increase the strength.

 

9. LIGHT DIFFUSION: algorithm description
The Light Diffusion setting has been developed for portrait photos, weddings, and close facial shots. It 
will smooth the blemishes in the face and create a more diffused, softer picture with less contrast.  Skin 
tones will often be slightly warmer/redder when this algorithm is enabled.

LIGHT DIFFUSION: adjustments

To enable simply turn ON.
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10. AUTOMATIC RED-EYE REMOVAL: algorithm description
Red-eye is caused when the camera’s flash reflects off the veins in the retina at the back of the eye. In 
other words, what we’re seeing is the subject’s blood vessels. Research shows that during the winter 
months, as much as 30% of photos suffer from red-eye.

To solve this problem, Athentech has teamed up with FotoNation (Tessera Technologies) to include their 
patented technology as part of the Perfectly Clear image correction suite. Using advanced recognition 
techniques, the presence of red-eye is automatically detected and removed. The technology is so 
sophisticated that it carefully retains those important glints and sparkles in the subjects’ eyes.

AUTOMATIC RED-EYE REMOVAL: adjustments

To active this algorithm, simply turn ON. Each photo will be automatically scanned and if red-eye is 
detected, it will be removed. If no red-eye is detected, then no red-eye will be removed.  
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Chapter 7
Batch Processing

Saving you significant time
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Overview
Since Perfectly Clear is designed to be a robust automatic correction solution for large volumes of 
images, you can use the Plug-In to accomplish this in Photoshop. It is a 2 step process:

1. Create an Action for Perfectly Clear

2. Batch process images using this Action

1

Step 1: Creating an Action for Perfectly Clear

2

1. Open Actions 
(located under 
“Window/Actions”) 

2. Press the “Create 
New Set” button
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3

4
5

3. Name your New Set 
(for example, “Perfectly 
Clear”).

4. Next select your 
new Set, and press 
the button to the right 
of #2 (“Create New 
Action”). This will create 
a specific action under 
your “Set”. You can 
create multiple actions 
(for example, a separate 
action could be created 
for each preset)

5. Name your Action
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6. Press the Record button .
Photoshop will remember everything 
you do from this point on. 

Load the Perfectly Clear Plug-in, 
select the preset you want to use  
(or fine tune a photo), and press 
the “okay” button.

7. Press the Stop button 

6

7

You can now press the play button and this 

Action will be performed on your photo.
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Step 2: Batch process images using your new Action

 Select File->Scripts->Image Processor. 

   1) Select your folder of images to correct

   2) Select your output folder where the corrected images will go

   3) Select your output file types. (Note: Each image can be saved as multiple image formats  
        using the checkboxes and you can also resize the images at this step if you desire)
 
   4) Select your action that you made in step 1 above that will be applied to each image.

This process will open any image file in the folder that Photoshop understands. Raw files will be 
processed with the Adobe Camera Raw default settings before the Perfectly Clear corrections are 
applied. Any jpgs or tifs (etc) in the folder being processed will also be corrected by Perfectly Clear.



www.athentech.com

Please Note: Your use of this software or these materials is subject to Athentech’s license terms.  
Please visit www.athentech.com for more information. © Athentech Imaging Inc. 2011


